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Abstract

MAVIS (Modeling and Analysis of Explosive Valve InteractionS) is a computer program that simulates
operation of explosively actuated valves. MAVIS was originally written in Fortran in the mid 1970’s and
was primarily run on the Sandia Vax computers in use through the early 1990°s. During the mid to late
1980’s MAVIS was upgraded to include the effects of plastic deformation and it became MAVIS II. When
the Vax computers were retired, the Gas Transfer System (GTS) Development Department ported the code
to the Macintosh and PC platforms, where it ran as a simple console application. All graphical output was
lost during these ports. GTS code developers recently completed an upgrade that provides a Windows
95/NT MAVIS application and restores all of the original graphical output. This upgrade is called MAVIS

111 version 1.0. This report serves both as a user’s manual for MAVIS 111 v 1.0 and as a general software
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Executive Summary

MAVIS (Modeling and Analysis of Explosive Valve InteractionS) is a computer program that simulates
operation of explosively actuated valves. These valve assemblies generally comprise an electrically
initiated explosive actuator, shear disk, plunger, housing, and tubes. In operation, pressure generated by the
actuator shears the disk and drives the plunger down a bore in the housing. As it travels down the bore, the
plunger cuts the tubes, opening a flow path, and continues until it becomes wedged into a taper in the
housing bore. The housing taper stops the plunger at the desired location and forms a seal to prevent gas
leaks through the actuator threads.

In a broad sense the code is relatively simple; it numerically integrates F=ma for plunger motion. The code
sophistication lies in determining the magnitude of all important forces acting on the plunger as it travels
down the bore. Important features included in the physical model are the explosive equation-of-state, the
elastic and plastic interactions between the housing and plunger, static and dynamic friction, tube cutting
forces, and trapped gas forces.

MAVIS was originally written in Fortran in the mid 1970’s and was primarily run on the Sandia Vax
computers in use then and through the early 1990’s. During the mid to late 1980’s MAVIS was upgraded to
include the effects of plastic deformation and it became MAVIS II. Shortly after, Sandia’s corporate
computing strategy changed and the Vax computers became less and less accessible. To maintain an
analysis capability, the Gas Transfer System (GTS) Development Department ported the code to the
Macintosh and PC platforms, where it ran as a simple console application. All graphical output was lost
during these ports. GTS code developers recently completed an upgrade that provides a Windows 95/NT
MAVIS application and restores all of the original graphical output. This upgrade is called MAVIS III
version 1.0.

This report serves both as a user’s manual for MAVIS III v 1.0 and as a general software development
reference. The intent of the software description is to help other developers understand the development
philosophy and software structure so that bugs may be more easily eliminated and future upgrades may be
simplified.




User’s Manual

Scope

This user’s manual is not intended as a comprehensive guide to the physical models implemented in the
MAVIS code. Model specific information can be found in references 1, 2, and 3. This manual serves only
to describe how to use the Windows 95/NT MAVIS III upgrade.

Overview

MAVIS (Modeling and Analysis of Explosive Valve
InteractionS) is a computer program that simulates operation
of explosively actuated valves, These valve assemblies
generally comprise an electrically initiated explosive actuator,
shear disk, plunger, housing, and tubes as shown in Figure 1.

In operation, an electrical signal initiates explosive burn. High-
pressure combustion products apply an increasing load to the
disk that seals the bore above the plunger. When the load is
sufficiently high, the disk shears and pressure is applied to the
plunger, which accelerates down the bore in the valve housing.

During this time the explosive continues to burn, generating
more combustion gases and tending to increase the pressure
load behind the plunger. At the same time, however, the plunger moves away from the actuator, increasing

Figure 1: Valve Operation

the volume occupied by the combustion products and tending to lower the pressure. MAVIS accounts for
both effects when determining the magnitude of this pressure load.

As the plunger travels down the housing bore it contacts and shears one or two tubes, opening a flow path.
MAVIS calculates these tube-cutting forces, which are a function of the tube mechanical properties and
geometry. MAVIS also accounts for pressure forces acting to decelerate the plunger due to gas trapped in
the bore or in the tubes.

‘With a properly designed valve, the plunger comes to rest as it wedges into a taper in the housing bore. The
forces that bring the plunger to rest include both the axial component of the geometric interference forces
and the friction generated at the sliding interface. While the original version of MAVIS included only
elastic interference forces, an upgrade performed in the early 1990’s included forces due to plastic
deformation as well.

In a broad sense the code is relatively simple; it numerically integrates F=ma for plunger motion. The code
sophistication lies in determining the magnitude of all important forces acting on the plunger as it travels
down the bore. At each time step taken by the numerical integrator, all applicable forces cited above are
summed and applied to the plunger. The resulting acceleration for that time step is then determined and
velocity and position resolved by further integration.




Code History

Raymond Ng wrote the original MAVIS in 1975 and provided Sandia’s first analytical tool for rapid
evaluation of explosively actuated valve parameters. The I/O structure of this original code, which was
written in Fortran, was relatively basic. Input was provided on a deck of punch cards and output was
delivered to a line printer directly connected to the computer. As the computing environment became more
interactive, a namelist formatted input file replaced the card deck. Summary output was written to the
screen while detailed output went to several different files. This first version of MAVIS included only
elastic interactions between the plunger and housing; all material effects were linear. In the mid to late
1980’s Sandia worked with the University of Washington to incorporate the nonlinear effects of material
plasticity into the physical model. The effort resulted in a sophisticated semi-empirical model that was
correlated to a series of finite-element analyses. Experimental work confirmed that this model correctly
predicted the plunger kinematic trends introduced by housing plasticity. This first major upgrade to the
original code was called MAVIS II.

Shortly after the plastic model upgrade, the Vax computers on which the code ran were relocated to
Sandia/NM and over the next few years became less and less accessible. When these computers were
finally retired, MAVIS was ported to desktop platforms, first the Macintosh and then the Windows PC. It
ran on these platforms in essentially the same manner as it did on the Vax: as a console application.
Unfortunately, because the MAVIS II plotting routines required a graphics library that was not available for
the Macintosh or Windows platforms, all graphical output was lost. The most recent upgrade, which
resulted in MAVIS II1, was performed to the PC version of the ported code. During this upgrade, the
console application was converted to a Windows 95/NT application with a modern user-interface and all
graphical output was restored.

Installation
Because MAVIS is intended to be installed on a limited number of machines, an automated installation
program was not developed. Instead, the program is installed manually. This section describes the steps

required to successfully install MAVIS on a Windows 95 and NT computer. The required files are shown
in Table 1.

Table 1: Required Files

File Description Dynamic Link Libraries
mavis.exe The main executable mfc42d.dll gswdii32.dll
mavisSGl.exe  The computational exe msvertd.dll dforrt.dil
gsw32.exe The graphics server mfco42d.dil dformd.dll
actuators.mdb  The actuator data base mfcd42d.dll

disks.mdb The shear disk data base msvcirtd.dll

plunger.mdb The plunger data base gsprop32.dil

housing.mdb The housing data base gswag32.dil

materials.mdb The materials data base




While the main executable, Mavis.exe, can be placed wherever the installer desires, the computational
executable, MavisSG1.exe, and the databases must reside in a specific directory. This directory may be
selected by the installer and must be identified to the system in the MAVISDIR environment variable. The
graphics server, gsw32.exe, can be installed in any directory identified in the path environment variable. In
addition, since MAVIS uses the Windows accessory WordPad to display textual information, the WordPad
directory must be included in the path environment variable. The dynamic link libraries, which represent
MFC', graphics server, and Fortran run time routines, may also be installed in any directory identified in

the path environment variable.

Setting the environment variables

Windows 95

Using a text editor, edit the autoexec.bat file to include the following two lines:

SET MAVISDIR=<mavis directory>
SET PATH=<wordpad directory>;%PATH%

where <mavis directory> is the path to the directory chosen for installation (for example

C:\Applications\Mavis) and <wordpad directory> is the directory in which Wordpad is located.

2. Restart the computer.
Windows NT

1. Log onto the target machine as an administrator.

2. Right-click the My Computer icon on the desktop and
select Properties from the context menu. Select
Environment from the resulting tabbed dialog to display
the environment variable page as shown in Figure 2.

3. Select any variable in the System Variables list box and in
the Variable edit box overwrite it with the following:

4. MAVISDIR

5. Inthe Value edit box type the path to the directory chosen
for installation, for example:

6. C:\applications\mavis

7. Select the Path variable in the System Variables list box.

8. If not already displayed in the Value edit box, add the

path to the graphics server, WordPad, and dll directories
to the path list.

! Microsoft Foundation Class

C:AWINNT \system3\cmd.exn
C:AAPPLICATIONS\DIFFUSE
CAMSDEVAINCLUDE CAMSDEVAMFClinl.
C:\MSDEVALIB.C:\MSDEVAMFCUDD:WMS..

C\BBUSIRTE
c:\program ;ﬂu}rjlevm\vc\i\d\daz\an

C\program fles\dsvatudo\shareddexmed. . £

Figure 2: System Properties



9. Click the Set button and then the OK button.

10. Restart Windows

Copying the required files

1. Copy the main executable, Mavis.exe, to any desired directory.

2. Copy the computational executable, MavisSG1.exe and the five database files to the directory
defined by the MAVISDIR environment variable.

3. Copy all remaining files to the desired directories.

Running MAVIS

1. Run MAVIS by double-clicking the Mavis.exe icon or an appropriate shortcut.

10



MAVIS Display

The MAVIS display is shown in Figure 3. The Mavis main frame, which also displays the name of the
currently selected document in its title bar, houses the system menu, toolbar, and main output window. The

main output window, in turn, contains two views, the geometry view and the graph view. These two views
present the user with all graphical output and describe all aspects of valve operation. The input tabbed
dialog, also called a property sheet, provides the user with the means to enter the valve definition, either by
inputting individual parameter values or by accessing a set of valve databases. Unlike the main output
window, the tabbed dialog is not constrained to remain within the main frame boundaries. It can be moved
to any desired location on the screen.

MAVIS allows the user to manipulate multiple sessions (documents) at the same time, a capability that is
useful when comparing severa! different valve designs. Selecting New from the File menu starts an
additional session. The number of concurrent sessions is limited only by the amount of available memory
and the user’s ability to maintain an understanding of the multiple windows. Although multiple main output
windows may be displayed, only a single input tabbed dialog window is shown. The values in the tabbed
dialog always correspond to the currently selected main output window.

Input tabbed
Mavis main frame dialog

Main output
window

B| i3 MevisDoct

Geometry
view

Graph
view

Figure 3: Mavis Display



Data from a MAVIS session may be stored by selecting Save or Save As from the File menu. If the data has
not yet been saved or if Save As is selected, the system presents the Save As dialog that allows the user to
select a file name and location for storage. Selecting Open from the File menu restores saved data. In this
case the system presents the Open dialog that allows the user to browse for the desired file.

Data in either of the main output window panes-(geometry or graph) may be previewed or printed by
selecting Print Preview or Print from the File menu. Note that these items act only on the currently selected
pane. Therefore, before using these commands the user should ensure that the desired pane is selected by

clicking anywhere in that pane.

The next two manual sections describe the input tabbed dialog and the main output window in more detail.

12



Input Tabbed Dialog

The tabbed dialog is used to enter information that defines the valve to be analyzed and is by initialized
with the parameters appropriate for a typical minivalve?, The input tabbed dialog contains seven pages, one

for program control data and one for each of six general categories of valve information: the explosive,
shear disk, plunger, housing, tubes, and trapped gas. The following sections describe each dialog page.

Control

The Control page, shown in Figure 4, allows the user to enter a problem title and parameters that control
program execution. The title is simply typed into the Problem Title edit box. The integration time step and
the maximum simulated time that the calculation is allowed to run are entered in the Time step and End
time edit boxes, respectively. Note that the end time entered by the user may not be reached — the MAVIS
simulation ends when the plunger comes to rest in the housing, If the user enters inappropriate data that
allows the plunger to continue its motion beyond the end time, the calculation will terminate when the end
time is reached.

- MAVIS can account for dimensional changes due to Mavis Input
function temperatures that are different than the
temperatures at which the geometries are defined. The
user enters the difference between these temperatures, in
Celsius degrees, in the Temperature difference edit box.
Function temperatures greater than the geometry
definition temperature are entered as positive values
while those less than the geometry definition temperature
are entered as negative values.

During the computational portion of MAVIS, the plunger
and housing are numerically divided into zones for

" processing. The user may enter the number of zones in
the Number of zones edit box. In general, the default
value is a good choice and needn’t be changed.

Clicking the Calculate button initiates a MAVIS
calculation and, if successful, updates the output in the
main window.

Figure 4: Control Page

? A minivalve is a specific class of explosively actuated valves used at Sandia to open flow paths in 1/8”
diameter tubes.




Explosive

The Explosive dialog page is shown in Figure 5. [
Here the user enters geometric and material data
about the explosive actuator that drives the plunger.
As a convenience, this page is linked to an actuator
database that contains data for several Sandia
actuators. Selecting one of the actuators in the
Actuator list box automatically enters all geometric
and material parameters. Any individual value may
be overridden by entering the desired value in the
appropriate edit box. Note that the user is currently
unable to transfer data to the database for later
recall. The system administrator must update the
database as the need arises. The parameters
described in this page are shown in Table 2.

The explosive mass is the mass, in grams, of the
explosive material. The thickness and diameter
parameters determine the explosive volume, which
is filled by the reaction products and acts to limit the
maximum pressure attained by the actuator. The

volume and density are calculated values and change

with the mass, thickness, and diameter. The free Figure 5: Explosive Page

volume, which refers to all unoccupied volume

immediately surrounding the explosive, also reduces

the maximum pressure. The diameter of free volume parameter is used solely in rendering the actuator in
the graphical geometry display. The thickness of free volume is calculated from the previous two values and
is also used only for geometry rendering. The coefficient of thermal expansion of the actuator header is
used to calculate volume changes due to temperature variations.

JWL EQS refers to the Jones-Wilkins-Lee explosive equation-of-state that MAVIS uses to model expansion
of the reaction products.

P=pA O +pB|1-—— |e® L PVE
RV RV 14

where P = pressure (MPa), V = volume ratio, E = specific energy (MJ/kg), P = density (kg/m*),A,B=
empirical coefficients (MJ/kg), R;, R, = empirical constants (R; ~ 4.0, R; ~ 1.0), W= fc, ~ 1 at large
expansions (usually 0.2 S W< 0.4).

The parameters in this section of the dialog are coefficients in the equation and determine the relationship
between pressure and volume over a wide range of expansion ratios. Reference 1 contains a more detailed
description of the Jones-Wilkins-Lee equation of state and the influence of each of its coefficients.
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The final two parameters, burn front acceleration and steady state velocity, provide explosive reaction rate

information. Acceleration refers to the slope of a linear approximation to the initial transient portion of the
burn front velocity. Once the initial transient is complete, the burn front becomes constant at the steady

state velocity.

Clicking the Apply button at the bottom of the page stores the entered data and updates the geometry
displayed in the main output window. The data is also automatically saved and the geometry updated when
the user clicks a dialog tab to activate a different page.

Table 2: Explosive Parameters

Parameter

Description

Explosive mass
Thickness

Diameter

Volume

Density

Free volume

Diameter of free volume
Thickness of free volume
Coef of thermal expansion

A

B

C

R1

R2

w

Specific energy

Burn front slope
Burn front SS Vel

The mass of explosive mixture (g)

The axial thickness of the explosive pellet (mm)

The diameter of the explosive pellet (mm)

The volume of the explosive pellet (mm®) - calculated

The density of the explosive pellet (mg/mm3) - calculated

The amount of unoccupied volume in the actuator (mm3)

The diameter of the free volume (mm)

The thickness of the free volume (mm) - calculated

The coefficient of thermal expansion of the actuator header material (1/C°)
The A coefficient of the Jones-Wilkins-Lee equation of state (MJ/kg)
The B coefficient of the Jones-Wilkins-Lee equation of state (MJ/kg)
The C coefficient of the Jones-Wilkins-Lee equation of state (MJ/kg)
The R1 coefficient of the Jones-Wilkins-Lee equation of state

The R2 coefficient of the Jones-Wilkins-Lee equation of state

The W coefficient of the Jones-Wilkins-Lee equation of state

The quantity of energy (MJ) released by one kilogram of explosive
material (MJ/kg)

The burn front acceleration (m/s%)
The steady state burn velocity (m/s)
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Disk

The Disk dialog page, shown in Figure 6, allows the
user to enter geometric and material information for the
shear disk that seals the housing bore above the plunger.
This page is linked to two databases, a disk geometry
and a materials database. In both categories selecting
one of the items in the list box automatically fills all edit
boxes. The user can override individual parameter
values by typing the desired value into the appropriate
edit box. Again, the user cannot currently transfer
information from the dialog page to the database. The
disk parameters are described in Table 3.

Table 3: Disk Parameters

Parameter Description

Thickness The thickness of the shear disk
(mm)

Diameter The diameter of the shear disk (mm)

Density The density of the shear disk

material (kg/m®)

Shear strength ~ The shear strength of the shear disk
(MPa)

Mass The mass of the sheared disk
(grams) - calculated

Shear Area . The area of the sheared surface
(mm?) - calculated

Shear Force The force required to shear the disk
(N) - calculated

Mavis In;

Figure 6: Disk Page

Once the disk is sheared it travels down the
housing bore with the plunger and
effectively increases the plunger mass.
MAVIS assumes that the disk shears at the
plunger aft diameter and uses the thickness
and density information to calculate the mass
increase. This mass, the full Diameter, and
the Shear Diameter are displayed in the
calculated values section of the dialog. Each

changes as the associated inputs change. The full diameter is based on the geometry data entered in the
housing page and is used only for rendering the disk on screen. Also shown in the calculated values section
are the shear area and shear force. Since the shear area is based on disk shear at the plunger aft diameter,
this dialog refers to the geometry section of the plunger dialog for this value. The shear force is simply the
product of the shear area and shear strength. Note that only two of the eight material parameters are enabled
for user input. Although selecting a material from the list box fills all eight parameter values, only the two
enabled values, density and shear strength, are used in the shear disk calculations.

Clicking the Apply button at the bottom of the page stores the entered data and updates the geometry
displayed in the main output window. The data is also automatically saved and the geometry updated when

the user clicks a dialog tab to activate a different page.
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Plunger and Housing

The Plunger and Housing dialog pages are shown in Figures 7 and 8. Each contains three categories of
information: geometry, material, and friction.

The data describing the plunger and housing geometry is entered as a list of x-y coordinate pairs that
approximate the cross-section geometry in a piecewise linear manner. Since the geometry is assumed
axisymmetric, only one “side” of the 2D cross-section needs to be defined. The data, limited to a maximum
of twenty points, is entered in a grid edit structure while a single edit box contains the number of active
coordinate pairs. The housing data describes both the internal bore and the external housing geometry. The
first data points represent the internal bore. External housing data begins at the first point whose x-value is
less than the x-value of the previous point. Unlike the housing geometry, the plunger description does not
require both an inner and outer surface definition. Plunger geometry without an interior surface definition
implies a solid (non-hollow) configuration. If an interior surface is desired (a hollow plunger), it may be
specified following the list of exterior points. MAVIS recognizes the beginning of the interior geometry
data when the current x-value is less than the previous x-value

Since the geometry list boxes are linked to corresponding databases, selecting an item from these list boxes
automatically fills the geometry data. For convenience, plunger mass and volume are included in the
plunger database. The user may also access the materials database to fill the plunger and housing material
edit boxes with appropriate values. Note that only the parameters actually used by the computational
portion of the code are enabled for user input. Since the plunger density and the shear strengths are not
used, their edit boxes are disabled. The material parameters are shown in Table 4. Of these parameters, all

Figure 7: Plunger Page Figure 8: Housing Page
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but the hardening coefficient are self-explanatory. The material stress-strain curve in uniaxial tension is
modeled with a bilinear approximation as shown in Figure 9.

Table 4: Material Parameters

Parameter

Description

Yield strength

Young’s modulus

Hardening coefficient

Poisson’s Ratio

Coef of thermal
expansion

0.2% offset yield strength in uniaxial tension (MPa)
Elastic modulus (MPa)

The slope of the second linear section of the bilinear approximation to
the material stress strain curve (MPa)

Poisson’s ratio (dimensionless)

Coefficient of thermal expansion (1 / C°)

stress

segment 2:
plastic region

segment 1:
elastic region

strain

Figure 9: Material Model

The first segment represents the elastic material region and is defined by the elastic modulus and yield
strength. The second segment represents the plastic region and is defined by the endpoint of the elastic
region and the hardening coefficient. The hardening coefficient is the slope of segment 2. The housing
material parameters also include the ultimate tensile strength. Although the user may enter a value in this
edit box, it is not currently used during the computational part of the program. It is intended as input for a
plunger “nose perimeter force” which is applied when the plunger nose diameter is greater than the
corresponding housing bore diameter.

The plunger description includes two parameters that are not found in the housing description, mass and
volume. Although the geometry and density might have been used to calculate the plunger mass, a direct
user definition is more accurate. The volume parameter represents the free volume in the plunger that the
actuator gasses fill once the shear disk has ruptured. As a check, the dialog calculates and displays the
plunger density. The density is based on the user defined mass and a plunger volume calculated from the
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geometry data. Note that since the geometry data is a piecewise linear representation and that it may not
include all plunger features, the density calculation is only approximate.

The frictional forces generated as the plunger interferes with the housing bore are determined with a simple
coulomb friction model where the frictional force is equal to the product of a dimensionless friction
coefficient and the normal interface force. The MAVIS friction model uses a coefficient of friction that
exponentially decays with increasing velocity. The functional relationship is of the form shown in

Figure 10.

f = fmin + (fsratic - fmi )e_AIV

0 — T d

0 50 100 150 200
refative velocity (m/s)

Figure 10: Friction Model

Where f = the friction coefficient, f,,;, = minimum coefficient of sliding friction, f;,. = the static friction
coefficient, A;= constant (sec/m), and V = velocity (m/sec). The user may change the values of f,is, fsarics
and Afto create the desired relationship between the coefficient of friction and the velocity. By selecting a
large value for Ay, the sliding coefficient of friction becomes constant at the value of f,;,. Although the
friction parameters are displayed in both the plunger and housing dialog pages, they apply only to the
plunger and housing interface. Each page provides access to the same data; changing a value in one page
changes the corresponding value in the other. The friction parameters are shown in Table 5.

A plot of the functional relationship between the friction coefficient and velocity as defined by the current
friction parameters can be viewed by selecting Friction Plot from the View menu. A typical displayed plot
is shown in Figure 11. Entering the desired value in the edit box at the bottom of the plot and clicking
Update Axis changes the maximum velocity for the plot.

Clicking the Apply button at the bottom of the page stores the entered data and updates the geometry
displayed in the main output window. The data is also automatically saved and the geometry updated when
the user clicks a dialog tab to activate a different page.




Table 5: Friction Model

Parameter Description

Coefficient of static The maximum friction coefficient when the relative velocity between
friction the housing and plunger is zero.

Min Coef of sliding Jin in the above equation

friction

Slope Coef of sliding Ayin the above equation

friction

Friction elienl

Vg%g 200

Figure 11: Friction Coefficient Plot
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Tube(s)

The Tube(s) dialog page is shown in Figure 12. The user BTN
may select either one or two tubes by clicking the
spinner control in the Number of Tubes edit box. If only
one tube is selected, the edit boxes for tube number two
are disabled. They become enabled when the user
selects both tubes.

Although the page and sections are labeled with the
word tube, the dialog allows the user to select either a
tube or diaphragm configuration. When a diaphragm
radio button is selected, the edit boxes and labels in that
section change to represent the parameters required for
diaphragm definition (an axial location and thickness).
Unlike the previous pages, the parameters in the Tube(s)
page are not linked to a database — they must be
manually entered. Six parameters, as described in Table
6, are required for each tube. The material properties
include the density in kilograms per cubic meter and the
shear strength in mega-pascals. Geometric data includes
both a description of the tube cross section and its
location in the valve housing. Because the code assumes

circular cross-section tubes, only inner and outer Figure 12: Tube(s) Page
diameters (both in millimeters) are required to complete

the definition. Entering a x-y coordinate pair in the

housing coordinate system specifies the tube location. The user must refer to the housing geometry
definition as entered in the Housing dialog page to determine the origin of this coordinate system. The
coordinate directions are fixed: the x-direction coincides with the bore centerline while the y-value
indicates the tube centerline offset from the bore centerline. If a diaphragm is selected, the diameters and
the y location are not required; they are replaced with the diaphragm thickness. The dialog also calculates
and displays the shear area for the tube or diaphragm, which is based on both the tube/diaphragm and
plunger geometry. This shear area calculation is valid only when the tube is positioned so that the plunger
intersects the tube’s internal flow passage.

Clicking the Apply button at the bottom of the page stores the entered data and updates the geometry

displayed in the main output window. The data is also automatically saved and the geometry updated when
the user clicks a dialog tab to activate a different page.
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Table 6: Tube Parameters “

Parameter Description
Density The tube material density (kg/m®) .
Shear strength The tube material shear strength (MPa)

Inner diameter
Outer diameter

X location

Y location

Thickness
Shear Area

The tube inside diameter (mm)
The tube outside diameter (mm)

The tube or diaphragm axial position relative to the housing coordinate
system (mm)

The offset between the tube centerline and the housing bore centerline
(mm)

The diaphragm thickness (mm)

The tube or diaphragm shear area (mm?) - calculated
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Gas

The Gas dialog page is shown in Figure 13. With this
dialog the user enters both gas pressure and inertial loads.
Gas pressures, their associated additional volumes, and
the gas gamma values (ratio of specific heats) for the
housing bore and tubes are entered in the Gas Pressure

i Mavis Input

Loads section of the dialog. The bore pressure is applied
to the plunger forward-facing area and produces a force
directed toward the actuator. As it travels, the plunger
compresses this trapped gas and increases the force. Once
the tubes are cut, their contained gas further adds to the
bore pressure and the plunger force. To simplify the gas
pressure calculations, MAVIS assumes immediate
pressure equilibrium and ignores transient gas flow from
the additional volumes through the tubes.

The user may specify both a directly applied plunger load
and loads induced by a spin environment. A positive load
is directed down-bore while a negative load is directed
toward the actuator. For spin loads, MAVIS assumes that
the housing centerline always intersects the center of
rotation. Therefore, only axial acceleration is considered.
Lateral accelerations that produce non-axisymmetric Figure 13: Gas Page
interface forces are not accounted for. A positive spin-

radius develops a plunger retarding force while a negative spin-radius aids plunger acceleration.

Table 7 summarizes the parameters in the Gas dialog page.

Table 7: Gas Parameters

Parameter Description

Initial pressure The initial pressure in either the bore, tube 1, or tube 2 (MPa)

Additional volume  The additional volumes associated with the above pressures (cc)

Gamma The ratio of specific heats for the trapped gas

Load The directly applied load that retards plunger acceleration down the
housing bore (N)

Spin radius The distance between the housing coordinate system origin and the center

of rotation (mm)

Spin rate The rotational velocity (rad/sec)
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Parameter Slider Dialog

In addition to using the tabbed input dialog pages, the
user may change valve parameter values with the
Parameter Slider dialog as shown in Figure 14. This
dialog is displayed by choosing Create Slider from the
Options menu. The dialog contains a list box with all
valve parameters, a slider control with edit boxes that
display the minimum, current, and maximum slider
values, and Set Slider and Close buttons. The dialog is
initially presented with an inactive slider. The user
activates the slider by selecting a valve parameter in the list box, either by double-clicking the item or by
highlighting it and subsequently clicking the Ser Slider button. Selecting the item causes the slider edit
boxes to be filled the current parameter value, 50% of the current value (minimum), and 150% of the
current value (maximum). When the user releases the mouse button after changing the current parameter
value by moving the slider, a new calculation is initiated and the display is refreshed with the results. The
user may reset the minimum and maximum slider values to 50% and 150% of the current value at any time
by clicking the Set Slider button. The user may also independently select the minimum and maximum slider
values by typing the desired values directly into the appropriate edit boxes. The current parameter value
adjusts accordingly as the minimum and maximum values change. As is the case with the input tabbed
dialog, only the parameter slider dialog for the currently selected child window is displayed.

Figure 14: Parameter Slider Dialog
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Main Output Window

The main output window contains two panes, the geometry pane and the graph pane as shown in Figure 15.
These panes are part of a splitter window and are separated by a splitter bar. The user may drag the splitter
bar up or down to reallocate window space to each pane. In addition, the user may resize the entire main
window by dragging its frame. The geometry and graph displays automatically resize as the window grows
or shrinks.

[ MavisDact _

Geometry Pane

Graph Pane

Figure 15: Main Output Window

Geometry Pane

The geometry pane displays the geometric data entered in the pages of the tabbed dialog and acts as a
visual indication of data integrity. As geometry data changes and is applied, either by clicking an Apply
button or activating a different dialog page, the geometry display automatically updates. In addition, when
a calculation successfully completes, the plunger is drawn in its post-function position. To print the
geometry display, the geometry pane must be currently selected (by clicking anywhere in the pane).
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Graph Pane

The graph pane provides access to plots that display plunger kinetic information. When the user clicks
anywhere in the graph pane it becomes active and the Plor menu and graph-related toolbar buttons are
enabled. The Plot menu, shown in Figure 16, allows the user to select one of sixteen plots for display. In
addition, the user can select whether to plot these quantities against time or against the plunger position
(stroke). The available plots are described in Table 8.

Table 8: Available Plots
Parameter Description
Acceleration The plunger acceleration
Velocity The plunger velocity
Stroke The plunger position
Expl pressure The pressure of the explosive gases
Volume The volume behind the plunger
Expl force The plunger force due to explosive gas pressure
Loss force The sum of disk, drag, cutting, and gas forces

Total force
Drag force
Cutting force
Gas force
Plunger
Explosive
Forces
Losses

The sum of explosive force and loss force

The frictional force at the plunger-housing interface
The tube cutting forces.

The trapped gas pressure forces

Combined velocity and stroke

Combined explosive pressure and volume
Combined total, explosive, and loss forces
Combined drag, cutting, and loss forces

As an alternative to selecting a plot through the Plof menu, the user may iterate

Figure 16: Plot
Menu

through the plot list by clicking the previous and next arrow buttons on the toolbar shown in Figure 17.

Right-clicking on the graph reveals the Graph Control property pages, as shown in Figure 18, and allows
the user to interactively change the graph’s appearance. The large number of available pages provides
access to almost all graph characteristics. Note, however, that changes made to one graph affect all others.
To print the graph display, the graph pane must be currently selected (by clicking anywhere in the pane).

Previous Next

Figure 17: Toolbar
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Graph Control

Figure 18: Graph Control Property
Pages
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Viewing the Input and Output Files

The files input to and written by the MAVIS computational program can be viewed by selecting the desired
items from the three presented in the View menu. The user may select either the last generated (current)
input file, summary report file, or plot data file. Because each calculation overwrites the files generated
during the previous calculation, only the most recent file sets are available. For simplicity and expediency,
the current version of MAVIS uses the Windows accessory WordPad to display the files. Note that an open
WordPad will not receive notice that the file it is displaying has been modified. If a new calculation is
performed while WordPad is displaying a file, that display will not be updated. Therefore, to ensure that
the most recent file is being viewed, the user should close currently running WordPads before selecting an
item from the View menu. Future versions of MAVIS might include an integral file viewer.

Input File

The input file, Mavis.dat, is a Fortran namelist formatted text
file read by the MAVIS computational program. It may be
viewed by selecting Current Input File from the View menu.
MAVIS then starts WordPad and loads the last input file
generated. The file contents may be manipulated, including
saved and printed, with the normal WordPad commands. A
sample display is shown in Figure 19.

| Explosive Valve Simulation
$data

tincre = 0.0001,
tmax = 0.2,
nzones = 50,
temp = 0,

emass = 0.11,
energy = O,
thke = 3.71,
diae = 4.29,
volfree = O,
diafree = 4.29,
expande = 0,
adet = 0.17,
bdet = 0.12,
cdet = O,

rdetl = 2,

rdet2 = 0.2,
vdet = 0,

uslope = 2e+007,
uexplo = 5200,
utly = 0.0,
rhod = 8220,
thkd = 0.25,

Summary Report

The summary report file, Mavis.out, which contains all user

input values and a summary of plunger stroke, travel time,
restroke force, and maximum velocity, is displayed by selecting
Current Report from the View menu. MAVIS then starts
WordPad and loads the last report generated. The report may
be manipulated, including saved and printed, with the normal
WordPad commands. A sample summary report is shown in

diad = 7.73,
sheard = 650,
expandd = 0,
pmass = 1.6,
yieldp = 1780,
youngp = 200000,
hardp = 200000,
poisp = 0.3,
volpl = 15,
tstatic = 0.4,
fmin = 0.07,
fslope =~ 0.03,
expandp = 0,

Figure 20. apdata = 15, 2
xp{1) = 0, yp{1) = 3.0842, it
xp{2) = 0.4647, yp(2} = 3.0842, :ii
xp{3} = 2.1548, yp(3) = 2.9759, et
. 4) = 2.984S, ypi4} = 2.2796, o
Plot Data File :::s: = 3.1115, g(s; - 2.9146, =
xp{6) = 5.588, yp(€) = 2.7559, :.:E
%p(7} = 6.8072, yp(7} = 2.0496, o
xpi8) = 7.1135, ypiB) = 1,9229, ‘x:{;_
{ 1 (S} = 7.4422, (9} = 1.8796, b
The plot data file, Mavis.raw, is a formatted text file that T Tt Tomss, &
contains the numerical data used to generate the plots in the e e Y 3
graph pane of the main output window. It is displayed by s - —

selecting Current Plot Data from the View menu. MAVIS then
starts WordPad and loads the last plot file generated. The file
contents may be manipulated, including saved and printed, with
the normal WordPad commands. A sample display is shown in Figure 21.

Figure 19: Input File Display
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M A v I s II
- Modeling and Analysis of explosive Valve Interactions
trrresten title : Valve Simulatien
tincre= 0.00010 ms tmax= 1.0000 ms noprint=0 nzones= 50 temp= 0. deg k
EXPLOSIVE j-w-1 coefficients
emags= 0,110 grams {vol= 53.63 mm3} adet= 0,170 mj/kg energy= 0.0 mj/kg
X {rhoe=2051. kg/m3} thke= 3.710 nm bdet= 0.120 mj/kg
diae= 4.290 mm cdet= 0.000 mj/kg uslope=2.E+07 m/s2
expande= 0.00E+0/k volfree= ¢€.00 mmd rdetls 2.00 uexplo= 5200. m/e
{thkfree= ©.00 mm) rdet2= 0.20 (t-rise= 0.019 ms)
ufly= 0.00 m/s diafree= 4.290 mm wdet = 0.00 {t-burn= 0.019 ms)
pPISsSC *shear*
{mass= 0.06 grams) thkd= 0.250 mm sheard= 650. MPa (area= 4.84 mm2)
rhod= 8220.0 kg/m3 diad= 7.730 mm  expandd= 0.00E+0/k (force= 3149.0 n)

PLUNGER

pmass= 1.60 grams yieldp= 1750, MPa youngp=200000. MPa volpls 15.00 mm3
{rhop=7028. kg/m3} poisp= 0.300 hardp= 200000. MPa cfact= .
npdata= 15 xp()-yp{() (zone size = 0.2057 mm) expandp= 0.00E+0/X
1) 0.000 - 3.084 2} 0.465 - 3.084 3} 2.155 - 2.976 4} 2.984 - 2.280
55 3.112 - 2.915 6} 5.588 - 2.756 7} 6.807 - 2.050 8} 7.114 -~ 1.923
9) 7.442 - 1.880 10} 7.771 - 1.923 11} 8.077 - 2.050 12} 9.120 - 2.652
13} 10.287 - 2.692 14) 0.000 - 2.565 15} 1,788 -~ 2.250

HOUSING

yieldh= 800. MPa youngh=131000. MPa fstatic= 0.400
rhoh= 8220. kg/m3 poish= 0.300 hardh= 131000. MPa fmin = 0.070
xmaxi= 22.670 surth= 0.000 u fslope= 0.010
nhdata= 11 xh{}-yh() expandh= 0.00E+0/k

1) -6.330 - 4.760 2) -0.330 - 4.760 3) ~0.330 - 3.880 4) 0.000 - 3.880
5) 0.000 - 3.073 6} 4.190 - 3.073 7) 8.990 - 2.780 8) 18.120 - 2.780
9) 20.020 - 0.000 10} -6.330 -10.000 11) 22.670 -10.000

TUBES 1 tubes/punch in the design
1 2 3 4 5
TUBE

rhot () kg/m3 B80CO. 0. 0. 0. 0.

diaot() o 3.175 0.000 0.000 0.000 0.000

diait(} mm 1.778 0.00C 0.000 0.000 0.000

{shear area) mm2 9.42 ¢.00 ¢.00 0.00 0.00

sheart({} MPa 2000. 0. o. 0. 0.

xt () mm 12.920 0.000 0.000 0.000 0.000
et yti{) ™ 2.540 0.000 0.000 0.000 0.000

expandt {} /k 0.00E+0  0.0CE+0 0.00E+0  0.GOE+0 0.00E+0

P} MPa 0.0 0.0 0.0 Q9.0 0.0

vel) mm3 0.00E+D 0.00E+C  0.00E+0 O0.00E+0  0.00E+D

gt{} 1.30 1.00 1.00 1.00 1.00
» G A S, SPIN Loads

pgas= 0.00 MPa vadd= 0.00E+0 mm3 ({vgas= 0.21E+3nm3) gamma= 0.000

gload= 0.000 gradius= ©0.000 gspin= 0.000

Valve Simulation

STROKE is  5.35 mm { 0.211 in.), reached in 0.0674 msec
Restroke Force will be 48257.3 N (Pressure of 1980.42 Mpa)

Max. VELOCITY is 143.453 m/s at  0.0521 msec

Figure 20: Summary Report

is] @avis.faw - WordPad
i £ o

eycle time (sec) acc {m/8*2) vel {m/s) pos {mm) P-act (F¥Pa) Vol (cc) Vol ratio Exp Force (N} ==
e
1 0.00000E+00 0.000002+00 0.00000E4+00 0.00000E+00 0.00000FE+C0 D.53626E+402 0.10000E+01 0.00000E+30 :,5‘2
2 0.100C0E-03 0.00000E4+00 Q,00000E+00 0.00000E+00 0.16034L-01 0.53626E+02 0.10000E+01 0.4791SEH00 'ﬁ’é
3 0.20000E-03 0.00000E+00 0.00000E+0C 0.00CCOE+0Q 0.64135E-01 0.53626E+02 0.10000E+01 0.19166E+02 "{E
4 0.30000E-03 0.00000E+00 0,00000E+00 ©.00000E400 0.14430E+00 0.53626E+H02 0.10000E+01 0.43124E+01 ég
s 0.40000E-03 0.00000E+00 0.00000E+0D0 0.00000E+00 0.25654E400 0.536262402 0.10000E+01 0.76664E+01 :k.(
[ 0.50000E-03 0.00000E+00 0.00000E+00 0.00000E+00 0.40085Z400 0.53626E+D2 0.10000E+01 0.11979E+02 n:ag
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Figure 21: Plot File Display
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Miscellaneous

Code Limitations

MAVIS currently performs only minimal input value checks. As a result, if the user errs when entering
values, the MAVIS computational routines may receive data that is not completely appropriate. Depending
upon the nature of the error, the computation may complete and provide erroneous output data that can
generally be identified in the output plots, On the other hand, since several routines are iterative and return
only upon successful numerical convergence, the computation may enter an endless loop of calculations. If
the calculation does not complete in a short amount of time (a few seconds), the user can open the
computational message output window by clicking on the MavisSG1 button on the taskbar. If the
calculation is experiencing difficulty, a message may be displayed in this window. Note that the taskbar
button is available only while the computational routines are executing. While future versions of MAVIS
may implement a more complete input-checking algorithm, the current version places the responsibility for
ensuring consistent input primarily upon the user.
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Software Description

This section briefly describes the MAVIS software development philosophy and structure. The intent of
recording this information is to provide future developers with the basis needed for code debugging or

upgrading.

Development Environment

The MAVIS upgrade was developed on a Windows NT PC using the Microsoft Visual Studio 97 integrated
development environment (IDE)’. Visual Studio 97 provides an environment that enables a developer to
efficiently write, test, and debug code. All C and C++ code was compiled with Microsoft’s Visual C++ 5.0
compiler while the Fortran was compiled with Digital Visual Fortran 5.0 compiler®.

Code Structure

MAVIS contains three executable files, Mavis.exe, MavisSG1.exe, and Sgw32.exe. Mavis.exe is the
executable image created by compiling and linking the C++ user interface code while MavisSGI.exe is the
image created by compiling and linking the Fortran computational code. Sge32.exe is a local automation
server that produces the plots in the graph pane of the main output window. The user runs MAVIS by
running the interface image. When the Control dialog’s Calculate button is clicked, the user interface runs
the computational code by spawning a new synchronous process. When the computational code terminates,
the system destroys that process and returns control to the interface code. With this structure, the interface
and computational codes run in separate process spaces and do not share memory.

The described structure was selected for one primary reason. The original Fortran MAVIS console
application, from which the computational code was derived, used very little interactive user input. Rather,
all important inputs were provided in a namelist formatted text file. Additionally, the code wrote all
important output data to similar text files. This file I/O configuration of the original MAVIS provided a
simple means of file-based communication between the interface and computational codes and required a
minimum of Fortran source modification. Mavis.dat is the input file written by the interface while
Mavis.out and Mavis.raw are the summary report and plot data files written by the computational routines.

Computational Code

As previously mentioned, the finished computational code is a minimal modification of the original Fortran
MAVIS application and is itself an executable application. The modifications, which are documented in the
source code, include the creation of a “once-through” program flow to replace the original looping flow
controlled by interactive user input. Minor syntactic changes were made to file opening statements and all

3 Microsoft Corporation, One Microsoft Way, Redmond, Washington 98052-6399,
http://www.microsoft.com
* Digital Equipment Corporation, Maynard, Massachusetts, http://www.dec.com
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non-essential screen output was eliminated. Further, Fortran statements were added to access the Visual
Fortran QuickWin run-time library, which adds some windowing capabilities to the application. These
statements prevent the application from displaying a window when it executes. Rather, the application
window is minimized and is visible only as a taskbar button. While it is active, however, the user may click
the button to expand the window. The computational segment was built as a Standard Graphics application
using the Visual Studio 97 AppWizard. A Standard Graphics configuration was chosen because it supports
the QuickWin library routines and allows the window to be minimized at execution.

When it executes, the code expects to find a namelist formatted text file called Mavis.dat in the same
directory in which it resides. If the file is not present, the code will not execute successfully. During
execution, the code writes two files: Mavis.out, which contains text-based summary report and Mavis.raw,
which contains the text-based plot data.

User Interface Code

The user interface code, written in C++, was built using Visual Studio’s MFC (Microsoft Foundation
Class) AppWizard as a MDI (multiple document interface) application. The Microsoft Foundation Classes
provide object-oriented wrappers around most of the Windows 95/NT API (application programming
interface) routines while the MDI architecture allows a user to concurrently work on several MAVIS
documents. The finished interface code comprises many classes, some of which were generated by the
AppWizard, most of which were developer-generated, and some of which were generated by the inclusion
of software components (ActiveX controls). The classes are summarized in Table 9. Some of the more
interesting classes are described in more detail below.

Property Sheet and Page Classes

The property sheet is the tabbed dialog that contains each of the seven property pages. Aside from its
normal base class implementation, the property sheet does little more than funnel application specific
instructions to the property pages. For example, when the property sheet receives Serialize and
WriteInputFile commands it simply passes them on to the individual pages.

Instead of the inputs being transferred to the document and stored communally, all data entered in a
property page is stored in that page’s member variables. Each page implements common functionality,
including the maintenance of its own display, data transfer from the database record sets to the member
variables, input file generation, and serialization. Display maintenance includes routine tasks such as filling
the edit boxes with appropriate values, enabling and disabling various controls, and storing edit box data to
the member variables. Data base transfer is accomplished by simply transferring data from each record set
variable to a corresponding property page member variable. The computational routine input file
(Mavis.dat) is written when the property sheet instructs each page to write its data to the file by issuing a
WriteInputFile command. Finally, each property page is responsible for storing and restoring its own data
and therefore implements its own Serialize method. A simple schema number written to the data file
provides for future backward compatibility.

The Plunger and Housing property pages contain a software component not found in the other pages: the

grid edit structure used to enter geometric data. Although the MSFlexGrid ActiveX component, which is
included with Visual Studio 97, is intended for Visual Basic applications, the environment is able to wrap it
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Table 9: User-Interface Classes

Table 9

Class name Description
CAboutDialog The About Mavis dialog class. This dialog is displayed from the Help menu.
CActuatorRecSet A record set class that provides a communication path to the actuator database
CChildFrame The applications main output frame window class. The splitter window resides

in this frame. The geometry and graph views are children of the splitter window.
CControlPP The Control dialog (property page) class
CDiskPP The Disk dialog (property page) class
CDiskRecSet A record set class that provides a communication path to the disk database
CExplosivePP The Explosive dialog (property page) class
CGasPP The Gas dialog (property page) class
CHousingPP The Housing dialog (property page) class
CHousingRecSet A record set class that provides a communication path to the housing database
CInputPS The input tabbed dialog (property sheet) class
CMainFrame The main frame class
CMaterialRecSet A record set class that provides a communication path to the material database
CMavisApp The application class
CMavisDoc The document class
CMavisGraphView The view class that displays the graphical kinetic information
CMavisView The view class that displays the valve geometry
CMSFlexGrid The grid edit structure class used to enter plunger and housing geometry data
CPlungerPP The Plunger dialog (property page) class
CPlungerRecSet A record set class that provides a communication path to the plunger database
CSplashWnd The splash screen class
CTubePP The Tube(s) dialog (property page) class

with a C++ interface, rendering it available to the C++ developer. Unfortunately, the raw component does
not implement an interactive editing capability — it is intended only for data display. However, some tricky
coding with a dynamically positioned topmost edit box delivers the required functionality in an effective, if
not graceful, manner.

Database Classes

MAVIS database access is built upon Data Access Object (DAO) classes rather than Open Database
Connectivity (ODBC). Using DAO provides a more object-oriented access and does not require that the
databases be registered with the system (although the code must still know where to find them). The five
record set classes are derived from CDAORecordset and provide this access to the Microsoft Access
databases (*.mdb). Most of the functionality is provided as the classes are built with the ClassWizard. Each
class’s DoFieldExchange() method actually performs the data transfer from the database fields to the
record set member variables.
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View Classes

The two view classes, CMavisView and CMavisGraphView fill the splitter-window panes in the main
output window with valve geometry and kinetic data plots, respectively. These view classes implement the
functionality required to draw and print their respective displays. Each also implements methods for
obtaining pointers to each of the property pages and hence the page’s public member variable data. For
ease of access without friend classes, if not for sound object-oriented development practices, all property
page member variables are declared public.

The geometry view reads the geometric data from each page and draws the valve display by executing the
DrawHousing, DrawPlunger, DrawDisk, DrawTube, and DrawActuator methods in its OnDraw method.
The OnDraw method, of course, is called whenever the display requires updating. The view also
implements window and viewport mapping to ensure that the image fills the view area.

The MavisGraphView plots are generated with a purchased software component called Graph Control.’
Like the MSFlexGrid, this ActiveX control is intended for use with Visual Basic applications and was
wrapped by the system with a C++ interface. Most of the difficult graphical work is performed by the
control itself. The view class is responsible, however, for defining the initial graph appearance, loading the
graph with the appropriate data, resizing the graph as the view pane grows or shrinks, and issuing print
commands in response to user print requests.

Databases

MAVIS accesses five databases to simplify data entry in the property pages. As previously mentioned,
access is provided by CDAORecordset derived classes, one for each database. The databases that MAVIS
uses were constructed with Microsoft Access 97 database management system. The database structures are
simple — each contains a single table with one field for each data value. These structures are summarized in
Tables 10 through 14,

This version of MAVIS does not allow the user to transfer data from the property pages to the databases for
later recall. The intent of imposing this limitation is to avoid contaminating the database with bad data.
Note that no access control is placed on the databases themselves. A user may alter the databases directly
by running Microsoft Access. Also note that a database structure change will confuse the record set classes
that are responsible for managing data transfer. Data base changes should be limited to the addition or
deletion of records. A future version of MAVIS might include a password-controlled mechanism for
allowing data to be transferred from the property pages to the databases.

5 Graph Control, Pinnacle Publishing, Inc. PO Box 888, Kent, WA 98035-0888, (425) 251-1900, Fax (425)
252-5057, htip:/fwww.pinpub.com
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Table 11: Actuators Database Table 10: Housing Database

, Database file:  actuators.mdb Database file:  housing.mdb
Table: explosives Table: geometry
« Field Data Type Field Data Type
ID long integer iD long integer
name text name text
mass single numPoints single
specific_energy  single X1 single
thickness single
diameter single X20 single
free_vol single Y1 single
free_vol_dia single
coef_t_expand single Y20 single
jwi_a single
!WLb s!ngle Table 14: Plunger database
jwl_c single Database fil | i
: ; atabase file:  plunger.m
jwl_rt single Table: geometry
. jwi_r2 single
Wlw single Field Data Type
iwl_slope single iD long integer
3 jwl_ssvel single name text
volume single
mass single
numPoints single
Table 12: Materials Database X1 single
Database file:  materials.mdb
Table: mech_props X20 single
Y1 single
Field Data Type
ID long integer Y20 single
name text
densit sing!
ensty nge Table 13: Disks Database
yield_strength single

ultimate_strength  single Database file: disks.mdb

Table: geometry
youngs_modulus  single
hardening_coef single Field Data Type
poisson single iD long integer
shear_strength single name text
- coef_t_expand single thickness single
diameter single
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File Viewing R

As previously mentioned, MAVIS permits the user to view files that contain the input data, summary
information, and plot data. MAVIS accomplishes this task by simply instructing the operating system to »
spawn a new Wordpad process with the target file name as a command line argument. The primary benefits
of this method are that it is exceedingly simple from a programming viewpoint and the user gains all of the
functionality of Wordpad, including the ability format, cut, paste, preview, and print the file contents. On
the other hand, this method has a shortcoming. Because the MAVIS process and the Wordpad process are
independent and share no data, MAVIS does not instruct Wordpad to update its contents as the file
changes. Therefore, if the Wordpad file viewer is open when the displayed file contents change, the
displayed information will no longer be current. A better method of allowing the user to view the file
contents should be implemented in the next upgrade, either by embedding a Wordpad object into the
MAVIS application or by incorporating a rich-text control as a simple viewer. In both cases, the viewer
could easily be notified of file contents changes and could respond by re-reading the file and displaying the
current information.
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